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Preface 
 
Why this e-Book? 
 
There are plenty of books available about Excel. Books that give you insights into the many tools 
and utilities that Excel has to offer. Not many of them handle these topics as if you were doing 
your daily job. As a Microsoft Excel expert, I often experience the fact that many of my customers 
are facing difficulties organizing their work. How do you build a proper spreadsheet and how do 
you organize your workbooks? 
 
I also experience the fact that many people, these days, think that Excel is only about PowerBI, 
and that PowerBI is the only tool that can solve your everyday challenges. 
 
Think again! 
 
PowerBI is a fantastic tool, but it is no more than that. It can solve many challenges when it comes 
to data, big data, or small data. But is has its constraints. One of them is that it only works in a 
perfect world where all your data is somehow present in the form of some structure. Situations 
in which the single source of entry is the single source of truth. Sadly, that is not always the case. 
Actually, most of the time it is not! 
 
In my 20 years of working with data (and Excel) I have never (yes, never) been in a situation where 
my data were perfectly organized. I always had to re-organize my files or databases before I could 
start analyzing data! 
 
That’s the real world.  
 
In this book, I present to you this real world. I describe the many phases of a project in which I 
need to organize and analyze data in order to find “the greatest country in the world”. 
 
To be brief: I can’t do that with PowerBI, PowerQuery or any other Power tool, because my data 
is too diverse as it comes from too many sources. 
 
For me, these were good reasons to write a book with a more practical approach. This e-book, 
“From Data 2 Dashboard in 1 Day”, is the result. It is the story of a project where a lot of files with 
data are transformed into a couple of dashboards that offer information and analyses about the 
countries of our world. 
 
  



So, is this the right book for you? 
 
YES! Why not? 
 
This book was primarily written for the experienced Excel user. If you are an Excel novice, the 
examples might be a bit complicated. For novices it may be wise to start with a book that covers 
the basics of Excel. At the moment, most of the books deal with those topics! 
 
To get the most out of this book, you should at least be a bit familiar with the following features: 
 

▪ How do I create a workbook and how do I save files? 
▪ How do I navigate within a workbook? 
▪ How do I format cells? 
▪ How do I create formulas? 
▪ How do I create and work with a table? 
▪ How do I create and work with a pivot table? 
▪ How do I create and work with a chart? 

 
With this knowledge at your disposal, it won’t be difficult following along. 
 
 
 
Acknowledgments 
 
It took a while to complete this book and it must have been annoying for my wife and daughter 
to see me running to my office almost immediately after dinner over the last couple of months. 
The only thing that I can say is that I want to thank the two of you for your patience and that 
daddy will make it up to you in the near future! 
 
I am also not a native English speaker, so it was not always easy to find the proper words. In other 
words, I could not write this book alone. Luckily, I had a fantastic interpreter who carefully read 
my book and took out all the mistakes I made. Kim, without you I would never have been able to 
complete this book! Many thanks for your incredible efforts to make this one readable! 
 
Finally, I want to thank you, the reader, for buying this edition. I hope that the tips and tricks that 
I presented will make your everyday Excel job a lot easier! And yes, your feedback is welcome! 
 
 
Mark Rosenkrantz 
The Netherlands 
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1 HOW AN EXCEL PROJECT CAME TO LIFE 

At the moment, big data, business intelligence and dashboard reporting are hot topics. Our 
hunger for data and our need to know more than we can absorb, is overwhelming. Whatever 
area or industry we work in, many people, almost daily, must deal with large quantities of data 
that ultimately must be shared or presented. 
 
I am an Excel specialist and in my world this is no exception. I am currently working on topics in 
the field of data visualization. Questions like, “What are the best performing items in the North 
Eastern region”, or “How many wireless devices were sold by Gary in April”, are among those 
that I must bring to life. In most cases by building a dashboard. 
 
A couple of months ago, I saw an episode of the 2012 series Newsroom, in which the main actor 
was asked why America is the greatest country in the world. That question inspired me! Is there 
a greatest country in the world anyway, and if so, how do we want to or need to measure that? 
Is it possible to find data that could bring such a question to life? 
 
Now, I am aware that the question itself is a very difficult question. The people in the world come 
from many different countries and cultures. Many of them are probably satisfied with the life 
they live. So, for many of us, the greatest country in the world is probably the country in which 
we live. 
 
Yet today, as we measure and compare everything, I thought it might be a challenge to find and 
evaluate data about all the countries in the world. If I could then show relations between entities 
like population, life expectancy, gross domestic product, press freedom and many more 
indicators and present it by means of a dashboard, it might shine some light on that question. 
 
So, this is how my Excel project started. Can I build a dashboard with data that is relevant enough 
to give an indication of the best country in the world to live in and, if possible, can I do this in a 
single day? 
 
  

https://www.youtube.com/watch?v=ZPHSXUS0_1c
https://www.youtube.com/watch?v=ZPHSXUS0_1c
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2 THE GOAL 

The purpose of this book is to describe how you can create a dashboard with Excel. It is organized 
in a way that you can follow along depending on your Excel experience and skills. The book is 
divided into three sections. Chapters 3, 4 and 5 make up the first section. It forms the theoretical 
part and covers the good habits of dashboard design. This part is also about the way we share 
our information and discusses the dos and don’ts when it comes to building a dashboard. 
 
The second section is the practical section. Chapters 6 to 12 concentrate on the building blocks 
of an Excel dashboard. Although each chapter can be seen as a standalone section with examples 
and alternatives, all chapters are connected logically. They represent the order of operations in 
which I should build my dashboard. 
 
In this practical section, I’ll take you through the various stages of collecting, organizing and 
formatting data so that it can finally be displayed as a dashboard. This section covers a whole 
range of topics. It includes working with text files, building a base table and how to validate and 
format data. It is about functions and tips and tricks. It shows the benefits of working with tables, 
pivot tables and pivot charts and explains the use of slicers. 
 
Chronologically, I will discuss the following: 
 

▪ Data  Valid data, tables and several rules of thumb to create a well-designed  
Excel database 

 
▪ Text Files  Importing fixed width or delimited text files, text numbers, tips and tricks  

to avoid several pitfalls when you import data from external sources and  
a couple of Excel functions 

 
▪ Tables  All the benefits of converting ranges into tables and the versatile 

VLOOKUP and SUBTOTAL functions 
 

▪ Pivot Tables The foundation of your dashboard and some tips and tricks to check 
whether your data is valid or not 

 
▪ Pivot Charts The graphical display of your data 

 
▪ Slicers  The most important element to create views of your data 
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It is important to realize that this approach is just one way of dealing with the subject. There 
might be other ways to achieve this goal. This is how I would approach this issue, based on the 
15 years of experience that I have with Excel and organizing data. 
 
You should also keep in mind that this book is NOT about PowerBI, PowerQuery, PowerPivot or 
PowerMap. Excel offers those tools, but they are part of a totally different ball game. These so-
called “power tools” are more complicated to work with and offer functionality that is better 
suited for data sets that exceed a couple of million records. In other words, this book is about the 
real, or old school Excel and the tools that it offers. 
 
The third section, which starts with chapter 13, is the part in which I describe the project. In this 
part, the dashboard comes to life. It will show you how to get from this: 
 

 

Figure 2-1: Multiple source files about the world we live in 
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to this: 
 

 

Figure 2-2: A well-organized Excel dashboard with pivot charts and slicers 

 
At first glance, creating such a dashboard may seem impossible to accomplish. Especially when 
the challenge is to do this in a day and you don’t have a clue where to start. Don’t worry, you 
won’t be the first to find out that many things in Excel might be easier than you thought! 
 
Time to get the ball rolling! 
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3 INTRODUCTION 

Since the beginning of this century, a dashboard has become a standard business tool. Numerous 
dashboard solutions have entered the market, but yet, with all the technology and options 
available, only little attention is paid to how to design informative and user-friendly dashboards. 
 
Traditional dashboard design focuses almost solely on defining some top priority metrics and a 
bunch of charts, put together on a single page. Many solutions offer the end user a dashboard 
containing lots of confusing information, where it should be presenting the critical information 
at a glance! Too often, the real message that should be conveyed to the audience, seems to be 
forgotten. 
 
Excel is one of those popular tools to build a dashboard with. Or a report. Or what? Often, a 
report is presented as a dashboard and vice versa. A spreadsheet, which clearly seems to be a 
dashboard, is presented as a report! Many people think that a dashboard and a report are equal 
and don’t see the difference. 
 
So, is there a difference between a report and a dashboard and what makes a dashboard 
functional and user friendly? Are there any design standards, or rules of thumb to follow when 
you want to build an informative dashboard? Are there any pitfalls to avoid when you want to 
present data that really matters? And, maybe even more interesting, is Excel a suitable tool for 
building interactive dashboards? 
 
These are some of the questions you might have when you want to share information. An 
appropriate dashboard must visually communicate the right information clearly and efficiently, 
so before you jump into the process of building a dashboard (using Excel) it is imperative to 
consider audience, content and design. 
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4 SHARING INFORMATION 

We improve what we measure and we know the importance of understanding the state of our 
business. Presenting data really matters and to do this, you may choose between a report and a 
dashboard. Many people think that a dashboard is some kind of report, while others consider a 
report and a dashboard to be equal. The truth is that they differ significantly. 

4.1 Reports 

A report is by far the most commonly used feature for distributing business intelligence. It is some 
kind of document with the sole purpose of communicating data. Although a report may include 
analysis, calculations and even a couple of charts, the most important feature of a report is that 
it does not lead the reader to a predefined conclusion. 
 
You might consider an Excel table to be some kind of report. It just holds data and gives the 
reader the opportunity to draw their own conclusions about what that data means. 

4.2 Dashboards 

A dashboard differs from a report as it visually focusses on data and does lead to one or more 
predefined conclusions. The purpose of a dashboard is to share information with an audience in 
a way they can understand, when and where they need it! 
 
A well-known expert on building dashboards is Stephen Few. In his book Information Dashboard 
Design, he wrote: 
 
“A dashboard is a visual display of the most important information needed to achieve one or 
more objectives consolidated and arranged on a single screen, so the information can be 
monitored at a glance.” 
 
From this we may conclude that a dashboard must therefore contain three key features: 
 

▪ A dashboard should only show data which is relevant to the business process 
▪ A dashboard should display data graphically, so that it helps to focus on trends, exceptions 

and other features relevant to the business process 
▪ A dashboard should lead to conclusions related to the business process 
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5 DASHBOARD BASICS 

When you want to share information, a dashboard certainly holds some advantages over a 
report. But will it be useful? Before you start building your dashboard, you must know who you 
are building your dashboard for. Who are your audience, what information do they need and 
what do they know? Understanding the audience of your dashboard will help you create a 
product that they will want to use. 

5.1 Dashboards - Audience 

Different people have different roles within organizations and therefore make different 
decisions. Not everyone needs the same information in the same time period and the skills to 
“dig into the numbers,” or use Excel, will differ. 
 
The issues mentioned above illustrate the importance of thinking about how to structure your 
data!  

5.2 Dashboards - Structure 

Stephen Few calls structure one of the greatest challenges of proper dashboard design. 
"Dashboard content must be organized so that it reflects the nature of the information and 
should support efficient and meaningful monitoring.” 
 
Information should not be placed just anywhere on the dashboard, nor should sections be sized 
simply to fit the available space. Items that relate to one another, should usually be positioned 
close to one another. Important items should appear larger, thus more visually prominent, than 
less important items. Items that must be scanned in a particular order, should be arranged in a 
manner that supports that sequence of visual attention. 

5.2.1 Why structure matters 

The structure of your dashboard is an opportunity to define the “right” way to look at business 
issues. The way you lay out information affects how your audience understands the big picture 
and how the smaller pieces fit together. 
 
At a more practical level, structure can serve as a navigational mechanism for the user. It shows 
where to start, and where to go next. 
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It cannot be emphasized enough: The success of your dashboard will depend on your ability to 
choose between useful, productive information and interesting but irrelevant information. 
Defining the proper requirements is therefore essential!  

5.3 Dashboards - Requirements 

Before you start setting up the requirements for a dashboard, let’s take a look at what a 
dashboard should be. 
 
In §4.2 we saw that “A dashboard is a visual display of the most important information needed 
to achieve one or more objectives consolidated and arranged on a single screen, so the 
information can be monitored at a glance.” 
 
When you consider this to be accurate, the key elements of a dashboard are: 
 

▪ Objectives 
▪ Information 
▪ Visualization 
▪ Display 
▪ Monitoring 

5.3.1 Objectives 

What are your organization’s core objectives and how does your dashboard contribute to those 
objectives? 
 
These questions affect what metrics should be included in your dashboard. This doesn’t mean 
that every metric should be included. Not at all. You should be highly selective in defining which 
metrics should be placed on your dashboard, but above all, every metric must be relevant to your 
organization. 
 
In order to choose the appropriate metrics, you might consider answering the following 
questions: 
 

▪ Does the metric measure contributions to the business objectives? 
▪ Is the metric really necessary to explain the contribution to the objectives? 

 
You should be confident that you can explain how every single metric on your dashboard 
contributes to the organization’s objectives. 
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5.3.2 Information 

In many cases the criterium to include information in a dashboard is whether someone influential 
thought it might be interesting. It should be better than that. The information that you present 
in a dashboard should be more than a lot of data on the screen. It should lead to productive 
action. 
 
Dashboard requirements often turn into a long list of unrelated metrics, dimensions, and 
impulsive analyses. The cause of this problem often arises from asking only one question: 
 
“What would you like to know?” 
 
When you stop there, you might run into a situation where your dashboard shows data that does 
not lead to any action. A better approach would be to ask a follow-up question: 
 
“What would you do if you knew this information?” 
 
This question leads to action and separates ordinary data from important and actionable 
information. 

5.3.3 Visualization 

A picture tells a thousand words. Because the human brain processes a single number or a picture 
as a unique piece of information, a data table filled with numbers requires the brain to process 
numerous pieces of information. As pictures are treated as a single piece of information, 
comprehension of and insight into a dashboard is therefore dramatically faster when you use 
charts or other visual elements. 
 
This is why a well-designed, highly visual dashboard will be more widely adopted by your 
audience. It is easy to read and quickly understood, whereas reports or text-based tables are not! 
 
When it comes to designing your dashboard, think about the use of colors, shapes, lines, 
thicknesses, degrees of shading, and other tools that improve visual perception. 
 
Avoid including 3D graphic treatments and graph types that nobody has seen before. Don’t make 
your dashboard look like an overly-dressed Christmas tree. Visualizations such as bar graphs, line 
graphs, heatmaps and scatterplots are popular because they are easy to understand. Everyone 
knows how to read them! 
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“Perfection is achieved, 
not when there is nothing more to add, 

but when there is nothing left to take away.” 
 

Antoine de Saint-Exuper 
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5.3.4 Display 

The purpose of a dashboard is to communicate critical information to your audience in a way 
they can understand. The way in which you present the information is crucial for it to be effective. 
Some say that you should put the data on a single page, where others believe that a dashboard 
can come in many forms. 
 
The paper from Juice Analytics in 2009, A guide to creating dashboards people love to use, could 
give some help reviewing factors that might influence what type of dashboard you should build. 
 
- Timelines:   How frequently is the data updated? 
- Aesthetics:  How important is the attractiveness of a dashboard? 
- Mobility:   Should the user be able to access the information on-the-go? 
- Connectivity:  Should the dashboard be connected to live data sources? 
- Data detail:  Is there an option to drill down for more context? 
- Data density:  How information-rich will views of the data be? 
- Interactivity:  Will the user benefit from interacting with the dashboard? 
- Collaboration:  Should the user be able to share the dashboard? 
 
Although the standard practice is to drop as many charts as possible onto a single page, there are 
some other options to consider. Juice Analytics set up the following table to address the factors 
mentioned above in relation to six types of dashboard: 
 

 

Figure 5-1: Building an effective dashboard 
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From Figure 5-1 it becomes clear that a plus sign means that the option is effective for that type 
of dashboard. The minus sign indicates that that choice is not effective. 
 
Figure 5-1 also shows that Juice Analytics favors an online app as the perfect choice for a 
dashboard. This is no surprise as they made that their core business! 
 
Note the fact that they think that Excel is a good candidate for a dashboard. Even though they 
only give Excel 2 plus signs, I think that there should have been more. Aesthetics, interactivity 
and collaboration are also very well implemented in the latest version of Excel, which makes it a 
perfect candidate for building a dashboard. 

5.3.5 Monitoring 

When you are designing your dashboard, you might want to add features that will make your 
dashboard more useful. Depending on the form, the dashboard can be much more than just a 
couple of charts on a page. You can highlight key information with interactive elements and have 
users customize their view of the data.  By adding such features, your dashboard will be easier to 
understand and easier to navigate. 
 
At the moment, there are lots of features available, but there are a few so-called must-have 
features. 
 

▪ Alerts: The ability to highlight information based on conditions. The alert may be activated 
when a metric goes outside of a particular threshold 

 
▪ Comparison: The ability to see two or more subsets of the data side-by-side. A line chart, 

for example, may allow users to view two regions as separate lines 
 

▪ Filters: The ability to (re)define the scope of the data in the dashboard. Filters can either 
be global (refining scope for the entire dashboard) or local (refining scope for a specific 
chart or metric or view) 

 
▪ Drill down: The ability to go from a summary view to additional details that provide more 

context for the information 
 

▪ Export: The ability to extract information from a dashboard. Exports to formats that let 
users do more with the data like Excel and CSV are preferred 
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5.4 Summary 

In this chapter I briefly discussed the principles of building a useful dashboard. Who are your 
audience and in what way do they affect the structure of your dashboard? Are you able to 
implement (the company’s) objectives and what are the best ways to visualize information? Do 
you also give your end users the opportunity to modify the (dashboard) data to their own needs? 
 
When you have addressed these questions, it is time to build your dashboard. Assuming that 
aesthetics, data detail, interactivity and collaboration are top priorities, and the fact that you are 
reading this book means that you chose Excel for visualizing your data. Good choice, as Excel is a 
perfect candidate for building a dashboard! 
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9 THE BASE TABLE 

In most cases, you will have an Excel workbook or a text file containing a table with all the data 
that you need available when you start your project. Sometimes, you may find yourself in a 
situation where things are not so well organized. 
 
In §6.4, I presented a situation where the data came from several tables. This is not so unusual, 
but does give some extra work. One of the tasks to complete first, is to combine those tables into 
one big table. I call that the base table. Combining in this case, actually means that there are 
three things to be done: 
 

▪ Create a base table with a “true list” of country names 
▪ Correct inappropriate country names in the other tables 
▪ Copy or transfer values from all other tables to the base table 

 
These tasks demand no particular Excel skills at all. It involves doing manual corrections, sorting, 
the VLookUp function, and a little bit of cleverness. 

9.1 Creating the base table 

From the tables that I downloaded, I chose the one with world regions as my base table. The 
reason for choosing this table as the base table, is that I expected this table to be the most 
complete, as it would have been very odd if there were countries missing. Apart from colors and 
other formats, Figure 9-1 shows a part of this table. 
 

 

Figure 9-1: The initial base table 

In this table, I should check all entries in the column Country Name and make corrections if 
needed. The result should be an accurate list of all the countries in the world. 
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9.2 Sorting the base table 

After creating the list of country names, it is a good idea to sort the table alphabetically by 
Country Name. This makes combining the other tables with the base table much easier. As sorting 
is such a common thing to do, Excel offers several options. 
 
When you are sure that the table contains only data, you can place a filter on the top row of the 
table, click the filter for the Country Name field and choose Sort A to Z. 
 

 

Figure 9-2: Using a filter to sort the list of countries from A to Z 

 
When you want to sort a list or a table, first select it. Don’t be tempted to simply select the whole 
worksheet thinking that Excel will know that it contains a table. You might be surprised by the 
destructive outcome! 
 
The best approach is to select the region that contains the table and select Editing > Sort & Filter 
> Custom Sort… on the Home tab. 
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By doing so, the Sort dialog appears. 
 

 

Figure 9-3: The default Sort dialog 

You can sort the table by clicking “Sort by” in the dialog. A list of fields, or columns, from the table 
unfolds and you can select a field by clicking on it. 
 

 

Figure 9-4: Sorting a table by Country Name 

If you need an extra level to sort your data by, you can click the Add Level button and select 
another field. This next sort level will be indicated as Then by. 
 

 

Figure 9-5: A second sort level, indicated by Then by 

In theory you can use 64 levels to sort your data by. It is useless to say that you will never get into 
a situation where you need to do that! 
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If you need to delete a sort level, you should first select that field and click Delete Level. In Figure 
9-6, I selected Then by Country Name and then clicked Delete Level to delete the second sort 
level. 
 

 

Figure 9-6: Delete the second sort level Country Name 

 
If all went well, the table will be sorted by the Country Name field and look like this: 
 

 

Figure 9-7: The base table sorted by County Name 
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9.2.1 Rules when sorting a table 

When you do a custom sort, keep the following rules in mind: 
 

▪ Before you start sorting anything, you should first select the top left cell of the table and 
press CTRL + SHIFT + →, followed by CTRL + SHIFT + ↓. If the table contains no empty 
records or empty fields, all data that must be sorted will be selected. This is indicated by 
the fact that the selection will reach the bottom right cell of the table 

▪ Be sure to select the option My data has headers, for otherwise your first row will be 
treated as a record and will also be sorted 

▪ Excel sorts data based on cell value, not on cell format 
▪ Empty cells will be sorted last 
▪ Sorting is not case sensitive, but you can change that by clicking Options… in the Sort 

dialog 

9.2.2 Possible issues when sorting a table 

▪ When you want to sort text, data that was imported from another application may have 
leading or trailing spaces. These are spaces which are inserted before or after your data. 
You should remove these spaces before you sort the data. Manually or by using the TRIM 
function. This function was discussed in §7.6.2. 

 
▪ When you want to sort numbers, be sure that all numbers are formatted as numbers. If 

the results are not what you expected, the field might contain numbers formatted as text 
instead of numbers. Excel offers several ways to convert these so called-text numbers. It 
has been discussed in §7.5. 

 
 
 
 

 After you created the unique list of countries and sorted the base table, you must repeat 
those steps for all the other tables from which you want to copy data. Depending on the 
number of tables, this might be either an easy, or time-consuming task! 
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9.3 Merging tables 

The next step in creating a base table is to add data from the other tables. Merging this data is 
about organizing those tables, using the VLookUp function and performing a copy, paste as values 
operation. There is no rocket science involved. The most important thing is that you sort all tables 
by Country Name before you start! 
 
The first table to combine with the base table is the table with World Population data. 
 

 

Figure 9-8: The table with World Population data 

Copy the table with World Population data, but leave three empty columns next to the Region 
field when you paste this data to the workbook containing the base table. 
 

 

Figure 9-9: Preparing to merge data from two tables 

Don’t worry about the fact that some columns are not formatted. You can do that later. 
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The next step is to extend the base table. Follow these steps to do so: 
 

▪ Add a field to the right of the Region field in the base table and name it Year 
▪ Add a field to the right of the Year field and name it Population 
▪ Format both field headers (like the Region field) 

 
The table should look like this: 
 

 

Figure 9-10: The base table with the added Year and Population fields 

9.3.1 Row and column headings 

You might wonder why I did not display row and column headings. This is because I don’t need 
them and you will find out later that you actually don’t need them at all! 
 
When you feel more comfortable with the visibility of worksheet headings, you can show them 
by clicking Show > Headings on the View tab from the ribbon. 
 

 

Figure 9-11: Showing worksheet Headings 
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9.3.2 AutoFill and Flash Fill 

Now that you have extended the base table, it is time to add data. This means filling the fields 
Year and Population. You first have to fill the Year field with the value 1970. 
 
You can do so by copying and pasting, but also by using the AutoFill or Flash Fill option. Follow 
these steps to fill the entire Year field with the value 1970. 
 

▪ Select the cell from the Year field 
▪ Enter the value 1970 
▪ Double-click the AutoFill handle (a little square at the bottom right of the selected cell)  

 

 

Figure 9-12: Double-clicking the AutoFill handle to fill an entire field 

 
That’s it. 
 
The result of this action is that all cells in the Year field will be filled with the value 1970. You 
would get the same result if you use the Flash Fill option from the ribbon. 
 
The Flash Fill option works as follows: 
 

▪ Select two cells below the Year field header 
▪ Enter the value 1970 in both cells 
▪ Select the first empty cell below the value 1970 
▪ Click Editing > Fill > Flash Fill on the Home tab 
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The AutoFill option is very useful, but might not always be not available! Why is that?  
 
AutoFill is an option that you can enable or disable. If you don’t see the little square at the bottom 
right of a cell, the AutoFill option is not enabled! 
 
To enable AutoFill, click the File tab on the ribbon and select Options to display the Excel Options 
dialog. Click on the Advanced section from the Excel Options dialog and place a checkmark at 
Enable fill handle and cell drag-and-drop to enable the AutoFill option. 
 

 

Figure 9-13: AutoFill enabled in the Excel Options dialog 

 
The next step is to copy population data for 1970 to the base table, but only when the country 
name in the table with population data equals the country name in the base table. You don’t 
have to do this manually. Excel has a perfect function built in to do this. 
 
This is the VLookUp function. 
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9.3.3 VLookUp - Retrieving values 

You might already be familiar with the VLookUp function. It is an excellent tool to find data, given 
a certain condition. Even though I hear many people say that they completely understand how 
this function works, they often make the same mistakes. 
 
So, what does Excel say about VLookUp and how does it work? 
 

 VLookUp: Look for a value in the leftmost column of a table and return a value in the same 
row from a column you specify. By default, the table should be sorted in ascending order 

 
The VLookUp function has the following syntax: 
 

=VLookUp(lookup_value; table_array; col_index_num; [range_lookup]) 
 
This syntax shows that VLookUp has three mandatory arguments. The fourth is optional. To keep 
it simple, I always explain the VLookUp function as the W function. 
 

▪ Lookup_Value  Who are you looking for? 
▪ Table_Array  Where are you looking for it? 
▪ Col_Index_Num What are you looking for? 
▪ Range_Lookup  Why are you looking for it? 

 
This is what VLookUp is all about. No more, no less. Now that you know the basics of the VLookUp 
function, how do you integrate VLookUp into your workbook? Take a look at what you already 
have. 
 

 

Figure 9-14: Copying data with the VLookUp function 
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From Figure 9-14 it becomes clear that data from column I, should somehow be copied to Column 
F, given the fact that the Country Names in columns C and H are equal. 
 
The updated table below, explains this a bit better.  
 

▪ Lookup_Value  Who are you looking for?  Country Name 
▪ Table_Array  Where are you looking for it? World Population table 
▪ Col_Index_Num What are you looking for?  2 (1970 is column 2) 
▪ Range_Lookup  Why are you looking for it?  False (exact match) 

 
Putting it together in words, I want VLookUp to do the following. Find the exact Country Name in 
the leftmost column from the table with World Population data and give me the value from the 
second column or field from the record with the corresponding Country Name. 
 
In Excel terms, cell F5 should get the following entry: 
 

=VLOOKUP(C5;H4:N200;2;FALSE)  
 

 

Figure 9-15: The VLookUp function in effect 

To make things easier to explain, I scrolled down the worksheet to show the last entry in the table 
with World Population data. 
 
The red square in Figure 9-15 shows that the VLookUp function refers to the entire table with 
world population data. Cell F5 retrieves the value from the second column of the record with 
Country name Afghanistan. 
 
The result in cell F5, is the value from cell I5. It is 11126123. 
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9.3.4 VLookUp - Tricky parts 

It is absolutely necessary to keep in mind that VLookUp looks in the leftmost column of a table! 
If Country Name is the third column in the table, then this is the column that the reference to the 
Table_Array should start with! 
 
You might also be tempted to fill the other cells in Column F from the base table by using the 
AutoFill option. This is not a good idea and here is the reason why! 
 
When you use the AutoFill option, the VLookUp function you entered will be copied down to all 
the records in the base table. When you take a closer look at Figure 9-15, you’ll see that the 
VLookUp function refers to two cell addresses. These are C5 and H4:N200. 
 
When you use AutoFill to copy the VLookUp function down to all the records, the last cell in the 
Population field gets the following entry: 
 

=VLOOKUP(C202;H201:N397;2;FALSE) 
 

 

Figure 9-16: The VLookUp function copied down to the last record 

 
Figure 9-16 gives two indications of why using the AutoFill option is not a good idea. 
 

▪ There is no result for Zambia, even though it is clear that Zambia did have a population in 
1970 

▪ The red square at the bottom right of the figure refers to the cell address H201:N397. This 
cell reference does not include any data at all 
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If you don’t have much experience with VLookUp, then this should make you suspicious. Zambia 
is present in the list and it does not make any sense to refer to an empty range of data! What 
went wrong? 

9.3.5 VLookUp - Absolute or relative 

What went wrong, is the way that you copied the formula. This was done in a relative way, where 
you should have copied it in an absolute way. You can differentiate between the two by using a 
dollar sign in the cell reference. 
 
Like this: 
 

=VLOOKUP(C5;$H$4:$N$200;2;FALSE) 
 
Entering this instance of VLookUp into cell F5, is what should be done. Inserting a dollar sign 
before the row and column reference from the first and last cell of the table, makes the reference 
to that table absolute. Absolute means that, no matter how far you copy the formula down, Excel 
will always refer to H4:N200. 
 
This is not the case for the reference to cell C5. This reference must remain relative, as you need 
to refer to different countries in the base table and not only to the first one! 
 
When you use the AutoFill option to copy this instance of the VLookUp function, the last entry in 
the base table will get a correct notation as well. 
 

 

Figure 9-17: VLookUp copied down in an absolute way 
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9.3.6 VLookUp - Finding data errors 

While VLookUp is an excellent tool to retrieve data, it gave me another benefit! 
 
Figure 9-17 shows that I did not create a very accurate list of countries in the table with world 
population data. The last couple of entries in the base table show which countries. There are no 
results for Venezuela and Yemen, as the #N/A error is returned. This means that those countries 
are either missing or misspelled in the table with world population data. The latter is the case as 
the table with world population data contains a record with data for Yemen, Republic. 
 
Before I continue, it is therefore time to go through that list again and make corrections. When I 
do that accurately, VLookUp will find those missing values for me. 
 
After I make the last corrections to the list of country names, the base table contains 198 
countries of which 194 have data. Two countries are not listed in the table with world population 
data and two countries simply did not have any population in 1970! As I can explain those four 
occurrences, I am satisfied with the result. 
 

 

Figure 9-18: Missing entries don't have to be incorrect! 

The first set of data has been added to the base table. It is now time to reconsider the next steps. 
These include adding the other columns with world population data, but also converting VLookUp 
function results into plain data. 
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15 FROM HERE 

During the time that I was writing this book and building the dashboards, I thought that there 
was something missing. Yes, I was able to collect a lot of data, but there is so much more which 
is relevant in order to be able to better answer the question: What is the greatest country in the 
world? 
 
Personally, I think that data about the use of the internet, cell phone subscriptions, CO2 emission 
per capita, the use of electricity, sanitation facilities, equality of income, homicide rates, youth 
unemployment, incarcerated people per capita and many more do add to this concept. 
 
The good news is that these data are available! 
 
The sad news is, that these data are only available for a small number of countries, from 2010 or 
2015 onwards. This, in my opinion, blurs the real picture too much. 
 
So what to do? 
 
As I really enjoyed creating this dashboard, I am considering publishing the dashboard online, 
updating it at regular intervals and adding more data. Would it be interesting for people from all 
over the world to have an overview of the state of the world available with a few mouse clicks? 
Would it be interesting to add a worksheet that contains features to compare countries? 
 
I guess it will be, so watch out for updates! 
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From Data 2 Dashboard in 1 Day 
 
 

▪ Learn how to build dashboards faster than ever before 
▪ Use only the old-school Microsoft Excel tools 
▪ No PowerBI, PowerMap, PowerPivot or PowerQuery needed 

 
 

Outsmart your colleagues at work 
 

Become the Excel expert! 
 

SIMPLY EXCEL 

SOURCE FILES AVAILABLE 

BUILD YOUR OWN! 

 




